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Training Goals: 

This training guide will equip teachers to enter grades, record attendance, create simple printed reports, 

and finalize their gradebook for progress report and/or report card printing. 

 

This guide was developed using GradeSpeed.NET 4.0. Please keep in mind that while this manual was 

developed to help teachers perform all the tasks necessary to record grades and attendance and allow for 

reporting, there are many functions of GradeSpeed.NET 4.0 that cannot be covered in a brief training 

session. Please see the GradeSpeed.NET User Guide and http://support.gradespeed.net for further 

information. 

 

For technical support issues, teachers should always contact their school’s technology support office. 

Campusware works closely with specific school personnel to correct any problems or to rectify training 

issues promptly, but cannot provide support directly to teachers. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This training guide copyright © Campusware, San Antonio, TX, 2007. All Rights Reserved. 

 

This document may be duplicated only by authorized personnel employed by schools using licensed copies 

of GradeSpeed.NET 4.0. Any other duplication or usage rights must be obtained by contacting 

Campusware directly. 
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Getting Started with GradeSpeed.NET 4.0: 

 

1. Open an internet browser and navigate to your school’s GradeSpeed login page. 

 

 
 

Select “Teacher.” The following page will appear: 

 

 
 

You may notice that you have the option to use a “virtual keyboard” to enter your password. The virtual 

keyboard allows you to use your mouse to “type” your password on an on-screen keypad. This helps 

protect you against keyloggers. There are software and hardware keyloggers. These devices read and 

store any information entered with the keyboard, such as usernames and passwords. When using the 

“virtual keyboard,” this sensitive data is protected as the keyboard is bypassed. 

  

 
 

If your school uses LDAP to manage user accounts, you may be able to log into GradeSpeed using your 

network login (your computer username and password). 

 

If you teach classes at more than one campus, your username and password will give you access to a 

gradebook account at each appropriate school. Click the desired school to log in to that campus. 

 

 
 



GradeSpeed.NET – Advanced Teacher Training Guide 

Updated 9/5/07 

4 

Once you have logged in, you’ll see the main gradebook page. 

 

 
 

You will see a taskbar across the top of the page. Each of these icons gives you access to a different 

portion of the gradebook. This taskbar is also constant, meaning that no matter what page you’re on, it 

will still be accessible at the top of the page. 

 

 
 

This training manual should be used in conjunction with the “Basic Teacher Training” manual.  

 

The “Basic Teacher Training” manual covers the following features: 

 

• Creating assignment “Categories”  

• Creating and managing “Assignments”  

• Generating “Progress Reports” 

• Generating various “Reports” on student data 

• “Cumulative Grades” 

• Taking and submitting “Attendance” 

• Designing and customizing the “Seating Chart”  

• Using the “Verify Gradebook” to verify all entered grades for a cycle. 

  

You may already be familiar with these options. If so, you can start learning how to use some of 

GradeSpeed.NET’s more advanced features. “Lesson Plans” and “Discipline” are covered in separate 

training modules. 
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User Profile: Create Custom Fields 

 

2. GradeSpeed.NET allows you to create custom fields for use within your gradebook. For example, if  you 

wanted to record each student’s textbook number, eye color, or shoe size, you could def ine a field that 

would allow you to store this information. To create custom fields, go to your “User Profile” by clicking 

your name on the left side of the main gradebook page. 

 

 
 

From the “User Prof ile,” click the “Create Custom Fields” link in the top-right corner. 

 

 
 

To create a custom field, first define the field name in the first open blank. 

 

 
 

Next, choose the type of field you would like using the “Type” drop-down list. 

 

 
 

 

For options with only a “yes/no” or “on/off” choice, you can use a checkbox. For 

example, if you simply want to record whether or not a student has turned in a 

permission slip, a checkbox would be appropriate.  

 

If you need to enter and store text, such as to record a textbook edition, use a 

textbox.  

 

For fields that could contain multiple options, like eye color or shoe size, use a 

drop-down list. 

 

If a drop-down list will be used, enter the choices that you wish to appear in the 

drop-down list in the “Values” column (this field should be left blank if a check 

box or text box is used). Each choice should be separated by a comma. Note 

that the choice itself cannot contain a comma.  
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Once you have your field options set the way you want them, click “Add Field.”  

 

 
 

Your new field will be added to any fields that have already been created, as shown in the list above. 

These fields can be edited or deleted using the “Edit” and “Delete” links on the right. 

 

Click “Return” to return to the “User Profile.” Click “Return” again to return to the main gradebook page. 
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Using Custom Fields: 

 

3. Once your custom fields have been created, you can make entries for them using the “Student List” 

page. To access the student list, click the “Student List” link on the left toolbar. The left toolbar is visible 

from most pages. 

 

 
 

Once you click the “Student List” link, you will be immediately taken to the Student List page. 

 

 
 

Notice that your custom fields are listed on the left side of the page. To display one of these custom f ields, 

check the box next to the desired field’s name, then click “Refresh.” 

 

 
 

The newly selected fields will then be displayed on the student list, as shown below. 
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You can then make appropriate entries for any of the fields displayed on the page. 

 

 
 

Click “Update” to save any changes you make. You can then uncheck any custom fields that you wish to 

“hide,” then click “Refresh” to remove them from the display. The data you entered remains stored, even 

when removing columns from the display. This keeps the student list simple and uncluttered. The “Custom 

Fields” feature gives you unprecedented ability to record, store, and access student information within 

your gradebook. 
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Display Student Fields: 

 

4. To adjust the way student information is displayed in the gradebook, attendance view, or seating chart, 

access the “Teacher Profile” and select “Display Student Fields” from the “View” drop-down list. 

 

 
 

The “Mode” drop-down list allows you to choose whether you are modifying the info displayed in the 

gradebook, attendance, or seating chart modes.  

 

 
 

For each mode, use the check boxes to indicate which pieces of information should be shown for each 

student. 

 

 
 

If a student has been dropped from a class, typically the student will still appear in the gradebook with all 

of his or her grades. The student will be moved to the bottom of the student list and will have a “(D)” next 

to his or her name. The “Hide Inactive Students” option will remove these students from the student list, 

but you can uncheck this option to display them again at any time. 
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Once you have selected the appropriate student information, use the “Sort Order” box to select the order 

you would like these fields to appear. Highlight the desired field, and then use the “Move Up” or “Move 

Down” button to move the field up or down in the display. 

 

 
 

To save your changes, click “Apply.” To save your changes and return to the main gradebook page, click 

“Update.” To discard all changes and return to the main gradebook page, click “Cancel.” 
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Advanced Category Options: 

 

5. To modify your category settings, click “Categories” on the main gradebook taskbar. 

 

 
 

Note that you can enter a “Spanish Name” for each category (if you don’t see the “Spanish Name” fields, 

use the “Hide Spanish Category Names” drop-down list and select “No”). You will have to translate and 

type this yourself, as category titles often use abbreviations or idiomatic expressions that cannot be 

automatically translated. 

 

Also, you can standardize your category settings for any grouped courses (see the “Basic Teacher 

Training” manual for information on grouping like courses by “group number”). Use the drop-down menu 

titled “Make category properties identical for all classes in this group:” and select “Yes” or “No.” 

 

Most of the remaining options on the “Categories” page pertain to grading/averaging methods. The 

“Student’s Advantage” option modifies the way the system selects automatically dropped grades.  

 

 
 

With the “Student’s Advantage” option turned on, the system will automatically drop the grades that result 

in the highest average for the student. For example, “Student’s Advantage” may drop grades that are not 

the numerically lowest, but that, because of the weight of their category, have the greatest negative 

impact on the student’s grade. If a student’s average is a “90”, and the student received a “70” for an 

assignment in a category weighted at 10%, and a “71” in a category weighted at 60%, the “Student’s 

Advantage” method would drop the “71” because the lightly-weighted “70” will not decrease the student’s 

average as much as the heavily-weighted “71” would have. 

 

“Total Points Logic” allows you to record raw scores for assignments with “possible points” values other 

than 100.  
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Click “Update” 

With Total Points Logic set to “No,” you can enter a raw score into the gradebook and it will automatically 

be converted to a percentage when you click “Update.” 

 

                         
 

With Total Points Logic set to “Yes,” your raw score entry will be preserved, but calculated as a percentage 

so that the average can be displayed properly. This setting should NOT be toggled off and on while grades 

are being recorded, as it can result in confusing and invalid grade entries. In the above example, the 

initial entry of “38” was appropriately converted to “95” with total points logic turned off. If, however, 

Total Points Logic was now turned on, the 95 would be calculated as a raw score – nearly 250% of the 

original score. 
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Advanced Assignment Options: 

 

6. GradeSpeed.NET 4.0 contains several advanced assignment options. You can create rubrics within your 

gradebook, import grades directly from a classroom grade scanner, and see if an attendance incident 

might have inf luenced a student’s performance on a specific assignment. Additional assignment options 

are covered in the “Basic Teacher Training” manual. 

 

To set up a rubric, add a new assignment, use the radio button at the top to designate the new 

assignment as a “Rubric,” and then create the appropriate number of “Rubric Tasks.” During the rubric 

task creation process, you must designate the rubric assignment that each task is assigned to. For 

detailed instructions on creating rubrics, see the “GradeSpeed.NET Rubrics” document. 

 

Import Grades from a classroom scanner: 

 

If you use a CPS grade scanner, or a grade scanner that produces a text file in the following generic 

format – “[student ID], [score]” – you can import individual assignment grades directly from this scanner 

file. Create the assignment, but leave each grade cell blank. Next, click on the assignment title on the 

main gradebook page to go to the “Grades by Assignment” page. 

 

 
 

Click the “Import” button on the left side of the page. An “Import Grades” window will appear.  

 

 
 

If you use a CPS scanner, select “CPS” using the “Type” drop-down list. If you use another scanner that 

can create a generic file, select “Generic.” 
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Once you have selected your “Type,” browse to the scanner file. 

 

 
 

Select and open the file. To finish, click the “Import Grades” button at the bottom of the window. If the file 

was produced in the correct format, you will see a message like this: 

 

 
 

(If an error window appears instead of the window above, then check the formatting of the selected file 

and make sure it is in the required “[student ID], [score]” format.) 

 

Click “OK.” The grades will be automatically entered into each “Original Grade” cell on the “Grades by 

Assignment” page. 
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Viewing Attendance Events on the Main Gradebook Page: 

 

If a student was absent or tardy on the due date for an assignment, GradeSpeed indicates this by 

automatically placing a colored box around the student’s grade cell for that assignment. 

 

 
 

• If the box is blue, the student received an “Excused Absence” attendance code for that period on 

the specified date.  

 

• If the box is green, the student received a “Tardy” attendance code for that period on the specified 

date. 

 

• If the box is red, the student received an “Unexcused Absence” code for that period on the 

specified date. 
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Report Options: 

 

7. You can access reports by clicking “Reports” on the main gradebook taskbar. In addition to basic grade 

list reports, you can also print attendance or roster reports, reports that detail the comment codes 

assigned to each student, reports that contain every assignment marked “Missing,” reports that 

summarize each student’s category averages, and more. 

 

Report Options: 

 

You may see the following options next to each report choice: 

 

“Print Student Name/ID” – use the radio buttons to indicate which student info should be printed. 

 

“Print All Classes” – use the radio buttons to indicate whether all classes, or only the current class should 

be printed. 

 

“Grade List Options” – use the radio buttons to specify the location of the assignment names: in column 

headers, or in a legend at the bottom of the page. 

 

“Print Grade Level” – use the check box to display the student’s grade level on the printed report. 

 

“Order by Grade Level” – use the check box to order the students on the report by their grade levels. 

 

“Weeks” – use the drop-down list to set the number of weeks that should appear on the “Class Roster.” 

 

“Period” and “Time Code” – use the drop-down list to choose the period and time code for the “Attendance 

Roster.” 

 

“Print Detail” – use the check box to select a simple or detailed “Attendance Roster.” 
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The Reports: 

 

Grade List - The “Grade List” report allows you to produce a printable report containing grades for each 

assignment. Also note that there is a “Paper Saver” version of the “Grade List” report. 
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Category Averages – The “Category Averages” report displays each student’s average grade for each 

individual assignment category. 
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Conduct/Comments – The “Conduct/Comments” report lets you see each student’s conduct and comment 

code entries for a given cycle. 
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Assignments – The “Assignments” report is simply a listing of each assignment, its category, and its 

assigned and due date. 
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Missing Assignments – The “Missing Assignment” report let you see all assignments with an “Msg” 

(“missing”) entered as the grade. This report will not, by default, list any grades that have been left blank. 

However, in Report Options, there is a checkbox that allows you to define whether you would like blank 

grades to be included. 
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Class Roster – The “Class Roster” report is a multi-week attendance roster that can be used to record 

attendance by hand. 
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Attendance Roster – The “Attendance Roster” report shows each student’s attendance records for the 

cycle. 
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Viewing Cumulative Grades: 

 

8. To view students’ averages all together, click the “Cumulative Grades” icon on the main taskbar. 

Students’ cycle averages, semester averages, exam grades, and overall averages can be viewed together 

on one page. When you look at this page, keep in mind that with some schools’ systems, the grades 

shown here may not be the averages calculated in your gradebook. Instead, you may see updated 

averages sent from the school’s student information system (SIS) instead. So just because a student’s 

cycle average doesn’t match your records, that does not necessarily mean there is a problem. 

 

 
 

Again, options may vary depending on your school’s SIS. In some situations, the previous cycle averages 

are open for editing directly from the “Cumulative Grades” page. This is not available with all SIS’s. Note 

that you can also use this page for conferences by checking the box labeled “Hide Names.” This allows you 

to show a student how the rest of the class is doing without compromising anyone’s privacy. 
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Using the Seating Chart: 

 

9. A basic explanation of GradeSpeed.NET’s Seating Chart tool can be found in the “Basic Teacher 

Training” manual. The following instructions are more specific and cover the tool’s more advanced 

features. To access the seating chart, click the “Seating Chart” icon on the main taskbar. 

 

 
 

It is possible that your school may have loaded student class pictures onto this page. If this is the case, 

you will see your students’ individual pictures rather than the generic boy/girl icons shown here. You can 

customize the information shown here in the “Teacher Profile,” as described in the “Display Student Fields” 

portion of this manual on page 9. 

 

Once the appropriate information is showing up on the page, you can modify the layout of student 

positions in your classroom. Using the “Sort” drop-down list, you may choose to place students in 

alphabetical order, boy-girl, girl-boy, chronological student ID number, or simply randomize the selection 

of the student order. 

 

 
 

You can also modify the way the information is displayed using the “Display Options” at the bottom of the 

page. You may have to scroll down a little bit for these options to become visible. 
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Customize the font size and the size of the student images using the “Font Size” and “Image Size” drop-

down boxes. The “Cell Width” and “Cell Height” drop-down boxes modify the size of the virtual “grid” that 

is used when you use the default “Shapes” to organize the seating chart. 

 

You can organize the page by dragging the students around (like desktop icons), or by using one of the 

predefined layouts in the “Shapes” drop-down list. 

 

 
 

The “Circle” shape will automatically arrange your students in a circle as shown below: 

 

 
 

If the “Grid” shape is selected, the “Columns” drop-down list will become active. This feature allows you to 

customize the exact layout of the grid shape. Meaning, if “Columns” is set to “5,” the seating chart will 

organize the student layout into a grid of 5 columns. 
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Click “Update” to save the layout that you have designed. You can also use the “View” drop-down list to 

change from basic seating chart mode to “Attendance” mode. This allows you to take attendance for each 

student from the seating chart. This tool is also very useful for substitute teachers, especially if the class 

pictures are loaded. 
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Advanced Student Profile Options: 

 

10. You have the ability to edit some student prof ile data for students in your class. To do so, click the 

“Student List” link in the left toolbar. This toolbar is visible from most pages within the gradebook. The 

“Student List” will appear. 

 

 
 

To display a custom field, use the “Columns” feature on the left toolbar. Check the box next to the field 

you want to display and then click the “Refresh” button (to read more about creating and using custom 

fields, see the “User Profile: Create Custom Fields” section on page 5 of this manual). You can then enter 

information for each student into these custom fields, and save it for viewing later. To view the “Grades by 

Student” page, click “Grade” in the appropriate row. To edit a student’s profile information, click “Edit” in 

the appropriate row. The “Student Profile” will appear. 

 

 
 

On this page, you can view and modify certain pieces of student information. However, much of this 

information comes straight from the SIS, and thus cannot be modified. You can select student 

“Characteristics” using your mouse (click and hold down the “Ctrl” key to select multiple characteristics). 

These characteristics are defined by the administration and are visible from teacher to teacher. 

 

If you wish to sort the students in your gradebook other than alphabetically, you can enter sort keys for 

each student. If you wish a student to be first in the list, simply enter a “1” in the “Sort Key” field. If you 

don’t want to sort all students, but simply want one student to appear at the bottom of the list, make any 

entry into the “Sort Key” field for that student and he or she will fall to the bottom of the list on the main 
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gradebook page. For example, if you enter a 1 in the Sort Key field of a student and you don’t modify any 

other students’ sort keys, the student will be sent to the BOTTOM of the list. However, if every student 

has a designated sort key, the student marked as “1” will appear at the TOP of the list. 

 

You can also use this page to access a student’s grades in other classes or view his or her master 

schedule. Click the “Schedule” button at the top of the page to bring up a new window that shows the 

student’s complete schedule, along with his or her average in each class. 

 

 
 

When you are finished viewing the student’s schedule, simply close this small window. 

 

Lastly, you can view any student’s campus-wide attendance records by clicking the “Attendance” button at 

the top of the page. 

 

To save any changes made to the student profile, click “Update.” To discard changes and return to the 

gradebook, click “Cancel.” 
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Transfer Students: 

 

Teachers can transfer students' grades from one section to another in their gradebook. Grades can only be 

transferred to a new section for a student if the scheduling change has already been made in the student 

management software. 

 

When a student is dropped from a section, a D will be displayed next to that student's name in the 

gradebook. 

 

 
 

To transfer a student who has been dropped from one class into another class, click on the student's name 

to access the Student Profile. 

 

 
 

To transfer the student's grades to the new section, click the green Transfer button at the bottom of the 

profile page. Note: this button will only appear if the student has already been dropped from the old 

section. The following screen will appear: 

 

 
 

Using the first drop-down list, select the class that the student has been dropped from.  

 



GradeSpeed.NET – Advanced Teacher Training Guide 

Updated 9/5/07 

31 

 
 

Indicate the appropriate student in the next drop-down list. 

 

 
 

Next, indicate the class that the student is to be transferred to. 

 

 
 

The information will be displayed as shown below: 

 

 
 

Click Transfer to save the changes and return to the gradebook. The student's grades will be transferred 

to the new section. 

 

Walk-In Average 

If a student moves from one section, taught by "teacher A," and is added to another section, taught by 

"teacher B," the student's average will transfer automatically to the new teacher's gradebook. This is 

called the "Walk-In" average and can be viewed on the Grades by Students page. To auto-fill the walk-

in grade into every assignment that was given before the student's transfer date, the "Use as 'walk-in' 

average" link in the top-right corner. 

 

 
 

NOTE: All student transfers must have identical initial and destination course ID's. 
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Additional Training Materials: 

 

Campusware also offers specific training documents that detail the use of the “Lesson Plans” module of 

GradeSpeed.NET. These are available on request from your campus or district administrators. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GradeSpeed.NET – Advanced Teacher Training Guide 

Updated 9/5/07 

33 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



GradeSpeed.NET – Advanced Teacher Training Guide 

Updated 9/5/07 

34 

GradeSpeed.NET 4.0 
Advanced Teacher Training Session 

Class Evaluation Form 
 

 

Training Date:  

 

Trainer:  

 

Campus/District: 

 

  

Did the session content meet your needs?   Yes �  No �   Somewhat � 

 

If “No,” what should be improved upon?  

 

Do you feel more confident using GradeSpeed.NET 4.0 now?   Yes �   No �   Somewhat � 

 

If “No,” what can be done to increase your confidence? 

 

Did the trainer cover the requested subject matter?   Yes �   No �   Somewhat � 

 

If “No,” what was left uncovered? 

 

Would you recommend this Training Session to others?   Yes �   No � 

 

If “No,” why not? 

 

Overall Rating (Circle One): 

Poor            Fair          Average      Above Average Excellent 

 

Other Suggestions/General Comments: 

 

 

 

 

 

 

 

 


